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Lyhenteet ja käsitteet

AutoCAD Architecture

AutoCAD-versio, joka on tarkoitettu rakennussuunnitteluun.

AutoCAD Civil 3D

AutoCAD-versio, joka on tarkoitettu yhdyskuntasuunnitteluun ja dokumen-

tointiin.

BIM Building Information Model eli tietomallinnus.

CAD Computer-aided Design eli tietokoneavusteinen suunnittelu.

dwg Tiedostomuoto, jota käytetään kaksi- ja kolmiulotteisten CAD-tietojen tal-

lentamiseen.

GUID Globally unique identifier eli tietotekniikassa hyödynnetty ainutkertaiseksi

tarkoitettu tunnusnumero. GUID on 128-bittinen satunnaisluku, joka esite-

tään yleensä 32:na heksalukuna yhdysmerkein ryhmiteltynä.

IFC Industry Foundation Classes eli kansainvälinen International Alliance for

Interoperability -järjestön kehittämä avoin ISO-standardoitu oliopohjainen

tiedostomuoto.

Loft AutoCAD-ohjelman komento, jolla luodaan 3D-solid-objektia tai pintaa

yhdistämällä kahta tai useampaa poikkileikkausprofiilia.

Lokitiedosto Taustaohjelman tilasta ja tapahtumista kertova tekstitiedosto.

NURBS Non-uniform rational basis spline eli matemaattinen malli, jota käytetään

käyrien ja pintojen luomiseen ja esittämiseen tietokonegrafiikassa.

RS Revit Structures, Autodeskin kehittämä tietomallinnusohjelma rakenne-

suunnittelijoille.



Solid Model Tilavuusmalli, solid model kuvaa kappaleen koko tilavuutta.

Spline Komento, jolla piirretään NURBS-käyriä, joita käytetään mm. vaativien

3D-mallien luonnissa.

Tietomalli Yleisnimitys kaikessa rakentamisessa käytettäville digitaalisille, tietoa

sisältäville, malleille, jotka kuvaavat tietyn rakenteen tuotetietoa.

TS Tekla Structures, Tekla Oy:n kehittämä tietomallinnusohjelma.

Tuotemalli Rakennuksen ja rakennusprosessin elinkaaren aikaisten tuotetietojen

kokonaisuus.

Vinoköysisilta

Ulkonäöltään riippusiltaa muistuttava siltatyyppi, jossa ajoratana toimiva

osa on ripustettu pylonista lähteviin vinossa asennossa oleviin köysiin.



1

1 Johdanto

1.1 Tutkimuksen tausta

Tietomallintamisen käyttö on hyvin yleistä talo- ja teollisuushankkeissa Suomessa,

mutta siltapuolella se on vielä suhteellisen nuori käytäntö. Vielä suurin osa siltasuunni-

telmista tuotetaan perinteisellä CAD-teknologialla. Kuitenkin kiinnostus 3D-tietomallien

käyttämiseen taitorakenteiden suunnittelussa on voimakasta ja yhä useampi yritys siir-

tyy vähitellen mallipohjaiseen suunnitteluun. Tietomallien yhteydessä käytetään eng-

lanninkielistä termiä BIM (engl. Building Information Model), joka tarkoittaa digitaalises-

sa muodossa olevaa rakennemallia, joka sisältää kolmiulotteisen muodon kuvauksen

lisäksi objektien tietojen kuvauksen. Tietomallin avulla pyritään hallinnoimaan raken-

nuksen elinkaarta suunnittelusta toteutukseen ja ylläpidosta purkamiseen. Kaikki vai-

heet tallentuvat digitaalisessa muodossa, jota projektin osallistujat voivat käyttää ja

tieto siirtyy osapuolten välillä mallipohjaisesti. Tietomallintamisen tavoitteena on laatia

kolmiulotteisen tarkastelun avulla mahdollisimman virheettömiä suunnitelmia, jolloin

suunnitteluvirheet voidaan huomata jo hankkeen alkuvaiheessa.

Suomessa työkaluna on useimmiten käytetty Tekla Structures -ohjelmistoa, joka sopii

siltatietomallintamisen varsin hyvin. TS:n mahdollisuuksista ja ominaisuuksista siltojen

tietomallintamisessa on tehty paljon tutkimuksia. Tekla Oyj tekee yhteistyötä suunnitte-

lijoiden kanssa ja sen vuoksi ohjelmaan tulee jatkuvasti lukuisia parannuksia.

Työn toimeksiantaja on WSP Group Oy suunnittelutoimisto, joka on kehittänyt tietomal-

lintamista jo monen vuoden ajan. Konsernin siltayksikkö on ollut suunnittelijana useas-

sa tietomallihankkeessa, joista tähän asti merkittävin ja haastavin on ollut Crusellin

silta. Vuonna 2013 WSP Finland voitti Helsingin kaupungin järjestämän suunnittelukil-

pailun siltayhteydestä Laajasalon Kruunuvuorenrannasta kantakaupunkiin. Kruunuvuo-

renselän ylittävä siltayhteys muodostuu kahdesta sillasta, josta pisin on Kruunuvuoren-

silta, jonka pituus on 1,2 kilometriä ja toteutuessaan sillasta tulee Suomen pisin. Sil-

tayhteys on tarkoitettu raitiovaunuille, kevyelle liikenteelle ja hälytysajoneuvoille.

Kruunuvuorensilta on rakenteeltaan kaareva vinoköysisilta. Sillan rakenne on geomet-

risesti haastava. Siitä on tuotettu 3D-malli AutoCAD Civil 3D -ohjelmassa. Mallia ei

mallinnettu Tekla Structures -ohjelmalla heti, koska mallintamisen alkuvaiheessa testat-
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tiin erilaisia sillan geometrisia vaihtoehtoja. Näin suuren ja geometrisesti vaikean mallin

tekemistä Tekla Structures -ohjelmassa pidettiin liian monimutkaisena. Seuraavassa

vaiheessa malli siirretään Tekla Structures -ohjelmaan, jossa 3D-objekteille lisätään

tietomalliominaisuudet. Tässä opinnäytetyössä selvitettiin, miten siirto onnistuu ja millä

tavalla kolmiulotteisesta geometriamallista, joka sisältää suuria ja geometrisesti moni-

mutkaisia objekteja, päästään tietomalliin, jonka objekteilla ja osilla on tietojen kuvaus.

1.2 Tutkimuksen tavoite ja menetelmät

Tämän opinnäytetyön pääasiallisena tavoitteena on tutkia erilaisia tapoja, joilla geomet-

riamallin siirto tietomallimuotoon onnistuu sekä kartoittaa mahdollisia ongelmia, joita voi

esiintyä mallin integroinnissa AutoCAD-ohjelmasta TS-ohjelmaan. Työssä tutkitaan

myös, miten sillan kansirakenteen pursotus onnistuu Teklan Beam Extruder -työkalulla.

Samaten selvitetään, mitkä asiat pitäisi ottaa huomioon jo CAD-mallinnusvaiheessa.

Tietoa haetaan haastattelemalla kokeneimpia tietomallintamiseen perehtyneitä WSP

Groupin työntekijöitä, tutkimalla internetissä ohjelmistojen virallisia tukisivustoja sekä

CAD:in ja Teklan nettiyhteisöjä. Saatua tietoa sovelletaan Kruunuvuorensilta-

projektissa. Tuloksena on tarkoitus saada onnistuneesti integroitu malli, jonka avulla

siltasuunnittelua ja myöhemmin rakennesuunnittelua voidaan jatkaa Tekla-ohjelmassa.

2 Hankkeen taustatieto – Kruunusillat

Vuonna 2012 Helsingin kaupunki järjesti Kruunusilloista kansainvälisen suunnittelukil-

pailun. Kilpailun tarkoituksena oli löytää kaikin puolin paras siltaratkaisu, joka yhdistäisi

kantakaupungin ja Kruunuvuorenrannalle tulevat uudet asuinalueet. Kilpailun kohde on

kaupunkikuvallisesti erittäin merkittävä, toiminnallisesti monipuolinen sekä siltapaikka-

na poikkeuksellisen vaativa. 18 kesäkuutta 2013 julkistettiin siltakilpailun voittajat, en-

simmäisen sijan sai WSP Finlandin ”Gemma Regalis” ehdotus, jonka pääarkkitehti on

Martin Knight.

Suunnittelualue jakautuu kolmeen erilliseen osaan, jotka ovat: siltayhteys Nihdistä Kor-

keasaareen - Finkensilta, Korkeasaaren pohjoisosaan rakennettava kulkuyhteys tarvit-

tavine lähialueineen sekä siltayhteys Korkeasaaresta Kruunuvuorenrantaan - Kruunu-
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vuorensilta, joka on yksipyloninen liittorakenteinen vinoköysisilta ja tulosillat ovat liit-

torakenteisia palkkisiltoja.

Kuva 1. Asemakaavan havainnekuva (1).

Kaavassa silta on varattu joukkoliikenteelle eli raitiovaunuille ja pyöräilijöille sekä jalan-

kulkijoille. Pelastusajoneuvot saavat käyttää siltaa tarvittaessa.

Kuva 2. Sillan suunnitteluvaiheet (2).

Kuvassa 2 on esitetty siltojen suunnitteluvaiheet. Tämä tutkimus kattaa projektin yleis-

suunnitteluvaiheen, jossa tuotetaan siltojen kolmiulotteiset AutoCAD-mallit, ja osan

siltasuunnitteluvaihetta, jonka suunnitelmat laaditaan tietomallipohjaisesti.

Esisuunnittelu,

suunnittelukilpailu
Yleissuunnittelu Siltasuunnittelu

Rakennus-

suunnittelu
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3 Hankkeen tietomallinnus

Kruunuvuorensilta on merkityksellinen ja haastava suunnittelukohde. Tietomallinnusta

ei ole aiemmin käytetty missään näin mittavassa infrarakenteessa. Hankkeen arvioi-

daan kestävään useita vuosia, mikä luo erityisiä haasteita tietomallinnukselle. Tietomal-

lia tullaan hyödyntämään koko projektin ajan sekä suunnittelussa että rakentamisessa.

Tietomallia käytetään hyväksi myös kohteen valmistumisen jälkeen käytön ja ylläpidon

vaiheissa. Tässä luvussa kartoitetaan sillan suunnitteluvaiheet ja tietomalleille asetetut

tavoitteet. Taulukossa 1 on lyhyesti esitetty jokaisen suunnitteluvaiheen tietomallitavoit-

teet.

Taulukko 1. Suunnitteluvaiheet ja tietomallitavoitteet (2, s. 3).

3.1 Esisuunnittelu

Esisuunnitteluvaiheessa mallintamisen tarkkuus on luonnostelun tarkkuudella, jolloin

mallin avulla voidaan havainnollisemmin vertailla vaihtoehtoisia ratkaisuja. Tarkkuu-

deksi riittää sillan näkyvien pintojen esittäminen. Objekteilta ei vaadita tilavuus- ja ma-

teriaaliominaisuuksia. Esisuunnittelun mallinnuksen ohjelmistona käytettiin AutoCAD

Civil 3D 2014. (3, s. 19.)

3.2 Yleissuunnittelu

Yleissuunnitteluvaiheen tietomallinnuksen päämäärä on hankkeen kattava havainnollis-

taminen. Sillasta mallinnetaan näkyvissä olevat rakenteet ja varusteet sekä siltaan liit-

tyvät maastorakenteet. Piiloon jääviä rakenneosia ei mallinneta eikä objekteilta vaadita

tilavuusominaisuuksia. Suunnitteluvaiheen lopputuotteena tuotetaan eri suunnittelualo-

ESI- JA YLEISSUUNNITTE-
LUVAIHE

SILTASUUNNITTELU-
VAIHE

RAKENNUSSUUNNITTELU-
VAIHE

Havainnemateriaalin tuotta-
minen

Yhteensovittaminen
ympäristön ja muun
suunnittelun kanssa

Virheettömät toteutussuunni-
telmat, määrät, yhteensovit-
taminen
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jen havainneaineistoa. Yleissuunnittelun mallinnuksen pääasiallinen ohjelmisto on Au-

toCAD Civil 3D 2014. (3, s. 20.)

3.3 Siltasuunnittelu

Siltasuunnitteluvaiheessa näkyvien osien lisäksi mallinnetaan perustukset kokonaisuu-

dessaan sopivalla tarkkuudella. Rakenteet mallinnetaan tietomalliobjekteina. Tietoa

siirrettäessä objektien nimi, sijainti, tyyppi ja geometria siirtyvät rakenneosan mukana.

Rakenneosat mallinnetaan tilavuusobjekteina, jolloin määrät luetaan suoraan mallista.

AutoCAD Civil 2014 -ohjelmiston lisäksi siltasuunnittelussa käytetään Tekla Structures

20 -ohjelmistoa. (3, s. 21.)

3.4 Rakennussuunnittelu

Rakennussuunnitteluvaiheessa tuotetaan virheettömät ja mittatarkat toteutussuunni-

telmat. Silta mallinnetaan kokonaisuudessaan varusteineen, laitteineen, raudoituksi-

neen, määrätietoineen ja immateriaalitietoineen. Rakennussuunnittelussa laaditaan

siltapaikasta yhdistelmämalli. Rakenneosat ja -järjestelmät mallinnetaan niin, että niistä

voidaan tunnistaa niiden merkitys ja tyyppi. Tietoa siirrettäessä objektien sijainti, nimi,

tyyppi ja geometria siirtyvät rakennusosan mukana. Rakennussuunnittelun mallinnuk-

sen pääasiallinen ohjelmisto on Tekla Structures 20. (3, s. 23.)

4 CAD-mallinnus

Kruunuvuorensillan mallintamisen haastavin ja vaativin vaihe on kannen mallin tuotta-

minen. Tässä luvussa käydään läpi tekniikkaa, jota käytetään pitkän ja geometrisesti

monimutkaisen rakenteen mallintamisessa. Yleissuunnitteluvaiheesta AutoCAD-

ohjelmassa mallinnetaan geometriamalli varusteineen. Tässä vaiheessa on jo suunni-

teltu mittalinja, jota siltarakenne seuraa sekä poikkileikkauksen kuvio on selvä. Ennen

kuin voidaan aloittaa mallintaminen, lasketaan sillan ohjauslinjan koordinaatit avaruu-

dessa.
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4.1 Solid modeling

Mallinnettaessa on käytettävä työkaluja, joilla luodaan sellaisia objekteja, joita on mah-

dollista tuoda TS-ohjelmaan ja konvertoida tietomallimuotoon. Vaikka tässä vaiheessa

ei objekteilta vaadita tilavuusominaisuuksia, on tarpeen tehdä malli käyttäen tilavuus-

mallinnusta. Tilavuusmalli eli solid model kuvaa kappaleen koko tilavuutta. Siirtyessään

Tekla-ohjelmaan solid-objektit säilyttävät muotonsa ja niitä voidaan muokata rajoitetus-

ti. Objekteille on mahdollista lisätä lisäominaisuuksia.

Jotta mallin kaarevat muodot eivät vääristy projektin myöhemmässä IFC-vienti vai-

heessa, CAD-mallissa kannattaa heti alusta käyttää yksikkönä millimetrejä.

4.2 Loft

Sillan kansi ja päällysteet mallinnetaan Loft-komentoa käyttäen. Loft-komennolla luo-

daan 3D-solid-objektia tai pintaa yhdistämällä kahta tai useampaa poikkileikkausprofii-

lia. Poikkileikkausprofiilit määrittävät objektin muodon. Loft-objektin oikean muodon

määrittämiseksi voidaan käyttää apuviivoja. Apuviivoina käytetään ohjausviivoja, jotka

alkavat tietystä pisteestä ensimmäisestä poikkileikkausprofiilista ja päättyvät tiettyyn

pisteeseen viimeisellä poikkileikkausprofiililla. Ohjausviivana käytetään sillan mittalinjaa

ja se piirretään spline-viivalla, joka on jatkuva useamman pisteen kautta kulkeva käyrä.

On mahdollista käyttää useita ohjausviivoja, jotka yhdistävät poikkileikkausprofiilin eri

pisteet. Tapauksissa, joissa on monimutkainen poikkileikkausprofiili ja polku, suositel-

laan käytettäväksi useampaa apuviivaa, jolloin varmistetaan, että malli ei vääristy. Ku-

vassa 3 nähdään sillan poikkileikkaus, johon on merkattu apupisteiden sijainnit, joiden

kautta apuviivat kulkevat.

Kuva 3. Kruunuvuorensillan poikkileikkausprofiili ja apupisteet, väreillä on merkattu sillan eri
osat, jotka kaikki mallinnetaan erillisinä kappaleina.
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Kuvassa 4 on esitetty alku- ja loppupoikkileikkausprofiilit sekä ohjausviivoja joista loft-

kommennolla pursotetaan kannen solid-mallia.

Kuva 4. Vasemmassa kuvassa näkyy kannen alku- ja loppupoikkileikkausprofiilit sekä ohjaus-
linjat, oikealla on näistä objekteista loft-komennolla pursotettu malli.

Loft-toiminnon herkkyyden takia varsinkin isot pursotukset kannattaa jakaa osiin sekä

varmistaa, että polkujen alku- ja loppupisteet ovat kiinni poikkileikkausprofiileissa täy-

dellisesti. Myöhemmin solid-objektit voi yhdistää union-komennolla.

4.3 Kannen mallinnus

Kuvasta 5 nähdään, että Kruunuvuorensilta jakautuu kolmeen osaan: vinoköysisilta ja

kaksi tulosiltaa, sekä että sillan mittalinja koostuu neljästä kaaresta. Tulosiltojen poikki-

leikkausprofiili ei muutu matkan varrella. Vinoköysisillan poikkileikkauksen alku- ja lop-

pupoikkileikkausprofiili on samanlainen kuin tulosillalla, mutta se levenee tasaisesti

pylonia kohti.

Kuva 5. Kruunuvuorensillan tasopiirustus.
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Teoriassa sillan osat on mahdollista pursottaa koko matkalle asettamalla kannen poik-

kileikkausprofiilit tulosiltojen alku- ja loppupisteille, leveämpi poikkileikkausprofiili pylo-

nin kohdalle ja piirtämällä splinella ohjausviivoja niiden väliin. Koska loft-komento on

herkkä, mallinnettaessa kappaleet vääristyvät tai niissä ei voi hyödyntää ohjausviivoja.

Kruunusillan oikeanmuotoisen mallin luomiseksi loft-pursotukset jaetaan viiteen osaan.

Vasen tulosilta pursotetaan yhdellä kappaleella. Vaihtuvan poikkileikkausprofiilin takia

vinoköysisilta pursotetaan kahdesta kappaleesta. Oikea tulosilta kasataan kahdesta

kappaleesta, koska sillan mittalinja koostuu kahdesta kaaresta.

5 Mallin tuonti Tekla Structures -ohjelmaan

Tässä luvussa käydään läpi tapoja tuoda ulkoinen malli TS-ohjelmaan. Käsitellään,

mihin tarkoituksiin nämä menetelmät sopivat ja minkälaisia rajoituksia näillä menetel-

millä on. Lisäksi pohditaan, miten ne toimivat Kruunuvuorensillan mallinnusprojektissa.

Tässä vaiheessa varaudutaan siihen, ettei objektin siirto tule onnistumaan täydellisesti,

ja siksi selvitetään, miten TS:llä pursotetaan kannen muoto käyttäen Beam Extruder -

työkalua. Lopuksi tutkitaan, miten tuoduille objekteille saadaan lisättyä tietomalliomi-

naisuudet.

5.1 Objektin tuonti IFC-referenssin kautta

Teklaan on mahdollista importoida IFC-referenssimalli. Ensin CAD-malli tallennetaan

IFC-muotoon, jonka jälkeen se tuodaan Tekla-malliin referenssinä. Tuotuja malleja voi

käyttää esimerkiksi törmäystarkastelussa, raportoinnissa sekä aikataulutustehtävissä.

Tuodun IFC-mallin sisäiset objektit voidaan konvertoida natiiveiksi TS-objekteiksi IFC

object converter -työkalulla. (4)

5.1.1 IFC

IFC (engl. Industry Foundation Classes) on kansainvälisen buildingSMART (aiemmin

tunnettu nimellä International Alliance for Interoperability) -järjestön kehittämä avoin

ISO/PAS 16739 -standardoitu oliopohjainen tiedostomuoto, joka mahdollistaa tietojen

siirron tietokonejärjestelmästä toiseen. IFC-tiedonsiirtoa käytetään tuotemalliperustei-

sessa rakennussuunnittelussa. IFC-standardin välityksellä tuotemallitietoa voidaan
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siirtää eri CAD-järjestelmien välillä sekä myös suunnitteluohjelmistosta erilaisiin ana-

lyysi-, tuotanto- ja tuotetieto-ohjelmistoihin. IFC- tiedostoformaatin välityksellä siirretään

3D-geometria ja parametreja. Standardi ei tue piirustusmuotoista siirtoa. (5.)

5.1.2 IFC-vienti

Tällä hetkellä hyvin monessa suunnittelu- ja mallinnusohjelmistossa on mahdollista

tallentaa malli IFC-formaattiin. Tässä tutkimuksessa IFC-export on tehty AutoCAD Ar-

chitecture 2015 ja Revit Structure 2014 -ohjelmissa.

AutoCAD Architecturessa, IFC-export-komennon käynnistämiseksi valitaan AutoCAD

näppäin > Export > IFC. Autodesk Revit Structuressa valitaan Revit näppäin > Export >

IFC

Vain aktiivinen, luontihetkellä auki oleva piirustus voidaan viedä IFC-tiedostoon. Vienti-

prosessissa syntyy kaksi tiedostoa:

 IFC-tiedosto, joka sisältää 3D-mallin sekä hankkeeseen liittyvää tietoa, kuten pro-

jektinumero ja nimi, tiedoston polku ja mahdolliset referenssinä liitetyt mallit.

 Lokitiedosto (engl. log file), joka sisältää tietoa mallissa olevista objekteista ja niiden

sijainnista koordinaatistossa. Tämä tiedosto tallentuu samaan paikkaan kuin IFC-

tiedosto.

IFC-tiedostoon viedyn mallin objektit sisältävät 3D-geometrisen tiedon lisäksi objektin

ominaisuuksia kuten objektin tyyppi-, nimi-, materiaali-, taso- ja tyylitietoa. Mallin objek-

tit viedään IFC-tiedostoon riippumatta sitä, onko yksittäiset objektit piilotettu pois näky-

mästä tai onko tasot kytketty pois.

On tärkeää, että CAD-mallissa yksikkönä on käytetty millimetrejä, sillä muuten IFC-

viennissä kaarevat muodot suoristuvat. Kuvassa 6 on esitetty kaksi samanlaista IFC-

formaattiin vietyä kappaletta. Vasemman kappaleen yksiköt ovat millimetrejä ja oikean

kappaleen metrejä.
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Kuva 6. Kuvakaappaus IFC-tiedostoon viedyistä kappaleista.

Kruunuvuorensillan malli sijaitsee globaalikoordinaatistossa ja on kaukana origosta.

TS-ohjelmassa työskentelyn helpottamiseksi, ennen kuin tehdään IFC-vienti, CAD-malli

siirretään lähemmäs origoa ja siirto dokumentoidaan.

5.1.3 IFC-referenssimalli

Referenssimalli on tiedosto, jota käytetään avuksi TS-mallinnuksessa. Referenssimalli

voi olla TS-ohjelmalla luotu malli tai toisella ohjelmistolla luotu ja TS-ohjelmaan impor-

toitu referenssi 2D-piirustus tai 3D-malli. TS tukee seuraavat tiedostoformaatit (6):

 AutoCAD *.dwg

 AutoCAD *.dfx

 MicroStation *.dgn, *.prp

 Cadmatic-mallit *.3dd

 IFC-tiedostot *.IFC

 IGES-tiedostot *.igs, *.iges

 STEP-tiedostot *.stp, *.STEP

 PDF-tiedostot *.pdf
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TS:ssa referenssimalli tuodaan painamalla File > Insert Reference Model -painiketta.

Tällöin aukeaa kuvassa 7 esitetty Reference Model Properties -valintaikkuna, missä

File name -sarakkeessa Browse-painiketta painamalla valitaan halutun referenssitie-

doston sijainti. Change detection -kohdassa voidaan valita referenssimallin vanhempi

versio, jonka avulla tarkistetaan referenssimallissa tapahtuneet muutokset. Attributes-

kohdassa voidaan tarvittaessa muuttaa mallin skaalausta sekä täytetään vientitiedos-

ton projektinkohtaisia tietoja ja kommentteja. Layers-kohdassa voidaan valita mallin

tasot, jotka halutaan tuoda.

Kuva 7. Reference Model Properties -valintaikkuna.

Kun tiedoston sijainti ja muut parametrit on määritetty, painetaan Apply-painiketta ja

valitaan piste, mihin referenssimalli sijoitetaan. Valittu piste määrittelee referenssimallin

origon. Jos lisätty malli on työalueen ulkopuolella tai se ei ole kokonaan tai lainkaan

näkyvissä, TS näyttää Objects outside the work area (Objektit ovat työalueen ulkopuo-

lella) -varoituksen. Tällöin työalueen laajentamiseksi klikataan Expand-painiketta.
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Kuva 8. Oletusreferenssimallisymboli.

Jos referenssimallin tiedosto ei ole valittuna tai Apply-painiketta ei ole klikattu mallin

valinnan jälkeen, TS näyttää kuvassa 8 esitetyn oletusreferenssimallisymbolin.  Sym-

boli voi myös ilmoittaa, että referenssimallia ei voitu näyttää, koska siinä ei ole näkyviä

objekteja tiedostossa, tiedosto on vioittunut tai TS ei tue kyseistä tiedostomuotoa.

Painamalla File > Reference Model List -painiketta avataan Reference Models -

valintaikkuna, jossa nähdään tällä hetkellä ladattuina olevat mallit. Mallit voidaan piilot-

taa, poistaa tai päivittää.

5.1.4 IFC object converter

Teklassa referenssinä tuodut IFC-objektit konvertoidaan IFC object converter -

työkalulla, joka voi muuntaa lineaariset IFC-objektit kuten pilarit, palkit, anturat, lattia- ja

kattolaatat sekä seinät natiiveiksi TS-objekteiksi.

Aluksi valitaan objekti tai objektit, jotka halutaan konvertoida. IFC-referenssimallin yk-

sittäiset objektit valitaan painamalla (Select objects in components) -

painiketta TS ruudun alapuolella.

Seuraavaksi valitaan Tools > Convert IFC objects. Konvertoimiseksi valitaan Convert,

jonka jälkeen TS muuntaa objektin natiiviobjektiksi.

Klikkaamalla Settings-painiketta avataan IFC object converter settings -valintaikkuna,

jossa päästään muokkaamaan muunnoksen asetuksia.
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Primary profile mapping -kohdasta voidaan valita, millä tavalla TS tulee tunnistaa ob-

jektien profiilit. Kuvasta 9 nähdään, että TS voi kartoittaa profiileja kahdella eri tavalla

(7):

 Jotta profiileja kartoitettaisiin ensisijaisesti vertaamalla profiilin nimeä IFC-mallin ja

TS profiililuettelon kesken, valitaan Profile name -vaihtoehto.

 Jotta profiileja kartoitettaisiin ensisijaisesti vertaamalla objektien mittoja, valitaan

Dimensions -vaihtoehto. Tarvittaessa voidaan vaihtaa profiilin kartoituksessa käy-

tettävää mittatoleranssia.

Kuva 9. Primary profile mapping -kohta.

Jos IFC object converter ei voi tunnistaa profiileja valitulla menetelmällä, käytetään

toista tapaa tunnistamiseen.

Ennen kuin suoritetaan IFC-objektin konvertointi natiiviksi TS-objektiksi, voidaan tar-

kastella profiileja tai materiaaleja, joita TS ei tunnista. Niille on mahdollista valita profiili

tai materiaali TS:n omasta luettelosta. Kun IFC object converter settings -

valintaikkunan alapuolella klikataan Check-painiketta, aukeaa Missing Mapping -

valintaikkuna, jossa on kaksi välilehteä: Missing Profiles (puuttuvat profiilit) ja Missing

materials (puuttuvat materiaalit). Molemmissa välilehdissä on vasemmassa sarakkees-

sa lueteltu IFC-objektin profiilit tai materiaalit, joita TS ei tunnista, ja oikeassa sarak-

keessa puuttuvalle profiilille tai materiaalille voidaan valita profiili tai materiaali TS-

luettelosta.
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Kappaleen konvertoinnin jälkeen Tekla-ohjelmassa voidaan luoda raportti konvertoitu-

neista IFC-objekteista. Raportin luomiseksi klikataan Report-painiketta Convert IFC

objects -valintaikkunassa tai TS luo raportin automaattisesti jokaisen konvertoinnin

jälkeen, kun IFC object convertor settings -valintaikkunassa on ruksattu Create report

after conversion -valintaruutu.

Kuva 10. Raportti konvertoituneista objekteista.

Kuvassa 10 on esitetty raportti, jossa on listattu konvertoidun objektin tietoja: ID-

numero, nimi, profiili, alkuperäinen profiili ja luokka. Luokka on numero 990-995 välillä,

joka kuvaa konvertoidun objektin tilaa. Silloin kun raportilta valitaan jokin rivi, niin ky-

seisellä rivillä oleva kappale tulee mallista valituksi.

5.1.5 Soveltuvuus ja rajoitukset

Ulkoisen mallin konvertointi IFC-referenssin kautta on toimiva tapa, jolla objektit saa

tuotua TS-ohjelmaan. Tässä menetelmässä on kuitenkin omia ehtoja, jotka rajasivat

sen hyödyllisyyttä varsinkin, kun yritettiin konvertoida Kruunuvuorensilta-projektin ai-

neistoa. Revit Structures - ja AutoCAD-ohjelmissa tehdyt IFC-exportit käyttäytyivät eri

tavalla.

Tämä johtuu siitä, että IFC Object converter ei voi konvertoida vapaamuoto-objekteja,

vaan ainoastaan AutoCAD Architecture -ohjelman työkalulla mallinnettuja seinä-, pilari-

, palkki- tai laattaobjekteja. Ikkunat, ovet ja aukot TS konvertoi antimateriaksi eli aukko-

objektiksi, joka leikkaa seinäpinnan. Portaat, rampit, vesikatot ja muut objektit siirtyvät
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IFC-exporttiin vapaamuoto-objekteina eikä niitä ole mahdollista konvertoida TS-

ohjelmaan. Myös Autocad Architecturen sisällä seiniksi tai laatoiksi muutetut solid-

kappaleet siirtyvät TS-ohjelmaan vapaamuoto-objekteina eikä konvertointi natiiviobjek-

teiksi onnistu.

Konvertoitaessa Revit Structures -ohjelmassa luotuja objekteja seinä-, pilari-, palkki- ja

laattaobjektien lisäksi IFC Object converter tunnistaa muitakin objekteja kuten portaat

ja rampit sekä vesikatot. Myös vapaamuoto-objekteista luotuja komponentteja voidaan

konvertoida TS-natiiviobjektiksi, kuitenkaan vähänkin monimutkaisemmat muodot eivät

siirry TS-ohjelmaan. Kuvassa 11 on mustavalkoinen kuvakaappaus RS-ohjelmasta.

Oikealla puolella näkyy IFC-referensina tuodut samat kappaleet TS-ohjelmassa. Lä-

pinäkyvää vaaleanpunaista objektia ei saatu konvertoitua TS-ohjelmaan kappaleen

muodon monimutkaisuuden takia.

Kuva 11. Vasemmalla RS-ohjelmassa vapaamuoto-objektina mallinnetut kappaleet. Oikealla
samat kappaleet TS-ohjelmassa.

Oikeanpuolinen kappale on pursotettu (kappaleen profiili säilyy samanlaisena) kompo-

nentti, jonka TS tunnistaa ja pystyy konvertoimaan. Vasenpuolinen kappale on hieman

geometrisesti monimutkaisempi (pohjan ja huipun profiili on erilainen), jota TS ei tun-

nista. Esimerkiksi harjakattoista vesikattoa ei ole mahdollistaa konvertoida, kun taas

tasokattoisen katon konvertointi onnistuu. Kun konvertoidaan porras tai ramppi, kaikki

objektin kappaleet räjähtävät osiksi ja TS tunnistaa niitä eri palkkikappaleina (BEAM).

Lisäksi tässä tutkimuksessa RS-ohjelmassa on kokeiltu tuoda solid-kappaleita CAD-

mallista, mutta näitä kappaleita voi käyttää vain viitteenä tai apuna mallinnettaessa RS-

ohjelmassa, eivätkä ne siirry exportissa IFC-tiedostoon.
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Vaikka tämä menetelmä osoittautui toimivaksi tavaksi konvertoida objekteja TS-

ohjelmaan, se jää hyödyttömäksi Kruunuvuorensillan projektissa, koska kaikki objektit

oli alun perin mallinnettu 3d-solid objekteina, ja kuten aiemmin on mainittu, objektin

konvertointi seinäksi tai laataksi AutoCAD Architecture -ohjelman sisällä ei tuo mitään

muutoksia lopputulokseen. Siirto Revit Structures -ohjelmasta antaa enemmän mahdol-

lisuuksia, mutta koska TS ei tunnista vähänkään monimutkaisempia RS-ohjelmassa

luotuja muotoja eikä RS-ohjelmassa pystytä täysin hyödyntämään CAD-tiedostosta

importoituja solid-kappaleita, tätä menetelmää ei voida hyödyntää Kruunuvuorensillan

projektissa.

5.2 Objektin tuonti Shape Catalog -työkalulla

Versiossa 20.0 TS-ohjelmaan on lisätty uusi Shape Catalog -työkalu, jolla TS:ssa on

mahdollista tuoda, viedä tai katsella toisella ohjelmistolla luotuja 3d-kappaleita. TS:n

Shape Catalog tukee seuraavat tiedostomuodot:

 *.skp

 *.dgn

 *.dxf, *.dwg

 *.ifc, *.ifcZIP, *.ifcXML

 *.igs, *.iges

 *.stp, *.step

 *.tsc

Kaikki Shape Catalog -luetteloon tuodut kappaleet tallentuvat mallikansioon. TS luo

kaksi *.xml-tiedostoa, yhdessä on objektin määritteet kuten nimi ja GUID-numero (ai-

nutkertainen tunnusnumero), toisessa on objektin geometriset ominaisuudet kuten

kappaleen koordinaatit. (8)
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5.2.1  CAD-kappaleen valmistelu

Tässä tutkimuksessa Shape Catalog -työkalulla on tuotu 3D-kappaleita *.dwg- ja *.ifc-

tiedostomuodosta. IFC-tiedostomuodosta ja IFC-export-prosessista on kerrottu tar-

kemmin luvulla 5.1.1 ja 5.1.2.

Ennen kuin kappaleet importoidaan TS:ssa, on syytä huomioida seuraavat asiat:

 Yhdessä dwg- tai IFC-tiedostossa pitää olla vain yksi objekti, sillä muuten TS

importoi kaikki tiedoston sisällä olevat kappaleet yhdeksi objektiksi.

 Isot kappaleet (esimerkiksi pitkät sillan kannet) kannattaa jakaa osiin, sillä muu-

ten kappaleen tuonti epäonnistuu.

 TS:n työskentelyn helpottamiseksi Kruunuvuorensillan mallin kappaleet siirre-

tään lähemmäs origoa. Siirto dokumentoidaan.

5.2.2 Shape Catalog

Shape Catalog -valintaikkunan (kuva 12) avaamiseksi valitaan Modeling > Shape Cata-

log. Kappaleita päästään importoimaan klikkaamalla Import-paikiketta ja seuraavaksi

valitaan importoitava tiedosto. Isokokoisen tiedoston tuonti saattaa kestää muutaman

minuutin. Importin tuloksena on kolme vaihtoehtoa (9):

 Import epäonnistuu. TS näyttää varoituksen epäonnistuneesta importista eikä

kappale näky Shape Catalog -luettelossa. Tämä tapahtuu jos esimerkiksi kap-

paleen muoto on liian monimutkainen tai kappale on liian suuri.

 Kappale tuodaan Solid-kappaleena. Shape Catalog -luettelossa tiedoston ni-

men vieressä lukee Solid (kuva 12). Kappale on vesitiivis tilavuusmalli. Kappale

on täysin muokattavissa ja kappaleella on tilavuustietoja.

 Kappale tuodaan Non-Solid-kappaleena. Shape Catalog -luettelossa tiedoston

nimen vieressä lukee Non-Solid (kuva 12). Kappale ei ole vesitiivis, jolloin ob-

jektissa saattaa esimerkiksi olla reikiä tai jotain reunoja ja pintoja puuttuu. Kap-

paletta ei tällöin pääse muokkaamaan eikä kappaleella ole tilavuustietoa.
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Kuva 12. Shape Catalog -valintaikkuna.

Importointiprosessin kulusta ja sen aikana mahdollisesti sattuneista virheistä saa lisä-

tietoa istunnon historian lokitiedostosta klikkaamalla Tools > Display Log File > Session

History -painiketta.

5.2.3 Importoidun objektin sijoittaminen TS-malliin

Shape Catalog -luetteloon tuotujen kappaleiden työalueelle sijoittaminen tapahtuu kap-

paleen materiaalista riippuen käyttäen joko  (Create Item) - tai  (Create Concrete

Item) -työkalua. Nämä työkalut aktivoidaan joko valitsemalla Modeling > Create Steel

part > Item tai Modeling > Create Concrete part > Item.

Painamalla - tai -painiketta hiiren tuplapainalluksella aukeaa kuvassa 13 esitetty

Item Properties - tai Concrete Item Properties -valikko, josta voidaan valita työalueelle

sijoittava kappale ja muokata sen ominaisuuksia.
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Kuva 13. Item- ja Concrete Item Properties -valintaikkunat.

Kappale valitaan Shape-kohdassa olevan Select-valikon kautta. Shape Catalog -

luettelo aukeaa ja sieltä valitaan tuotu kappale. Kun klikataan Apply-painiketta ja vali-

taan kaksi pistettä, TS luo kappaleen valittujen pisteiden välillä alkaen ensimmäisestä

pisteestä kohti toista pistettä. Position-välilehdessä voidaan muokata kappaleen asen-

toa ja määrittää sen alku- ja loppupiste suhteessa sen ankkurointipisteeseen.

5.2.4 Soveltuvuus ja rajoitukset

Tässä luvussa esitetty tapa konvertoida objekteja on todettu toimivaksi ja antaa huo-

mattavasti enemmän mahdollisuuksia konvertoida Kruunuvuorensilta-projektin aineis-

toa, mutta samoin kuin edellisen 5.1-luvun menetelmällä, tälläkin menetelmällä on omia

ehtoja ja rajoituksia.

Aluksi Shape Catalog -luetteloon tuotiin kappaleet, jotka ovat dwg-muodossa. Sen jäl-

keen samat kappaleet tuotiin TS-ohjelmaan IFC-muodossa. Importoitaessa dwg-

muotoon tallennettuja kappaleita Shape Catalog -työkalu ei pysty tunnistamaan geo-

metrisesti vaikeita muotoja solid-kappaleina. Esimerkiksi yhtäkään Kruunuvuorensillan

kannen kaarevasta osasta ei tunnistettu tilavuusmallina. Istunnon historian lokitiedos-

tosta selviää, että näistä kappaleista puuttuu pintoja. Joskus puuttuvat pinnat nähdään
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tutkimalla TS-ohjelmaan tuotuja objekteja. Muissa tapauksissa kohdat, joista puuttuu

pintoja ovat niin pieniä, ettei niitä nähdä silmällä tutkimalla. Lokitiedostossa näkyvät

puuttuvien pintojen koordinaatit. Kuvassa 14 on esitetty esimerkkejä puuttuvista pin-

noista.

Kuva 14. Shape Catalog -työkalulla tuodut dwg-kappaleet, joissa näkyy puuttuvat pinnat.

Tutkimuksessa saatiin selville, että jos importoitu kappale on tallennettu dwg-

tiedostomuotoon, ei sillan kannen mallia pysty tuomaan TS-ohjelmaan tilavuusmallina.

Geometrisesti vähemmän haastavat objektit kuten maa- ja välitukirakenteet, jotka on

tallennettu dwg-muotoon, tuodaan TS-ohjelmaan vaihtelevalla menestyksellä. Siirto

tapahtuu hyvin epävakaasti, ja on tapauksia, jolloin joku kappale ei siirry solidina. Mutta

jos sama kappale siirretään lähelle origon nollapistettä ja peilataan tai kierretään, kap-

pale siirtyy solid-kappaleena. Lokitiedostossa nähdään, että yhdeltä objektilta puuttuu

pintoja ja toinen taas siirtyy ongelmitta. Tällä tavalla on onnistuttu tuomaan suurin osa
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Kruunuvuorensillan tukirakenteista solid-kappaleina, mutta osa niistä piti siirtää lähelle

origon nollapistettä tai niiden alkuperäistä sijaintia piti muuttaa, mikä tarkoittaa sitä, että

kappaleet joudutaan sijoittamaan oikeisiin paikkoihin käsiin.

Kaikki IFC-formaattiin tallennetut sekä yksinkertaiset että hyvin monimutkaiset objektit

tuodaan onnistuneesti TS-ohjelmaan. Osa objekteista ei siirry sellaisenaan, vaan ne on

jaettava osiin. IFC-vientiä suorittaessa objektin muotoja hiotaan. TS-ohjelmaan tuoduis-

ta kappaleista ei puutu pintoja eikä niissä esiinny muita geometrisia virheitä, jotka estä-

vät objektin importoinnin tilavuuskappaleena. Dwg- ja IFC-pohjaiset objektit näyttävät

erilaisilta tuotuina TS-ohjelmaan, koska IFC-tiedostosta tuoduista objekteista puuttuu

muotojen ääriviivoja.

Kuva 15. Vasemmalla on dwg- ja oikealla on IFC-muodossa Shape Catalog -työkalulla tuodut
objektit.

Kuvassa 15 on esitetty kaksi samanlaista kappaletta, vasemmalla on dwg- ja oikealla

on IFC-tiedostosta tuodut objektit. Taulukossa 2 nähdään, että molemmilla objekteilla

on samat mitat ja tilavuudet. Painossa on alle 200 gramman ero ja pinta-alalla alle 1



22

cm2 ero.  Sen perusteella voidaan todeta, että kuvassa 15 esitetyt kappaleet ovat omi-

naisuuksiltaan samanlaisia.

Taulukko 2. Kuvassa 15 esitettyjen kappaleiden ominaisuudet.

dwg IFC
Net length
Gross length
Weight
Weight(Net)
Weight(Gross)
Volume
Area
Name
Material

12679.6 mm
12679.6 mm
7898749.65 kg
7898749.65 kg
7898749.65 kg
3159.500 m³
32388733.76 cm²
CONCRETE ITEM
C30/37

12679.6 mm
12679.6 mm
7898749.47 kg
7898749.47 kg
7898749.47 kg
3159.500 m³
32388733.68 cm²
CONCRETE ITEM
C30/37

Tässä luvussa käsitelty menetelmä on täysin toimiva. Sen avulla on saatu konvertoitua

kaikki Kruunuvuorensillan mallin objektit. Kuten on jo aiemmin mainittu, CAD-

mallinnusvaiheessa on käytettävä yksikkönä millimetrejä. Vaikka AutoCAD Architectu-

rella voidaan vaihtaa yksiköt, jonka jälkeen malli skaalautuu oikeaan kokoon automaat-

tisesti, objektin muodot vääristyvät saman verran kuin mallissa, jonka yksiköt ovat ol-

leet alunperinkin metreinä.

5.3 Beam Extruder

Beam Extruder on siltamallinnuksessa usein käytetty TS:n lisätyökalu, joka luo peräk-

käisiä palkkeja millä tahansa poikkileikkausprofiililla. Rakenteita mallinnetaan käyttäen

avuksi ulkoista Excel-tiedostoa, joka sisältää profiilin x-, y-, z-koordinaatteja sekä profii-

lin nimen, jota kunkin palkin kohdalla käytetään. Lisäksi Beam Extruderilla voidaan mal-

lintaa palkkeja, jonka poikkileikkausprofiilit ovat muuttuvia ja joissa on vaihtelevat alku-

ja loppupoikkileikkausprofiilit. (10.)

Lisätyökalu on ladattavissa Teklan Extranetista osoitteesta:

https://extranet.tekla.com/BC/tekla-structures-en/extensions/beam-extruder/Pages/

Default.aspx. Työkalu on asennettavissa Teklan 16.1-20.1 versioille. (10.)
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5.3.1 Objektin pursotus

Beam Extruder -työkalun asennuksen jälkeen käynnistetään TS ja valitaan Tools >

Marcos. Macros-valikosta valitaan Beam Extruder ja klikataan Run-painiketta. Tällöin

aukeaa kuvassa 16 esitetty Beam Extruder -valintaikkuna.

Kuva 16. Beam Extruder -valintaikkuna.

Excel file -dialogille syötetään Excel-dokumentin tiedostopolku. Excel mapping -

kohdassa dialogeille kartoitetaan Excel-sarakkeiden nimet ja määritetään otsikkorivien

määrä. Kuten kuvasta 17 näkyy, Excel-arkissa on oltava x-, y- ja z-koordinaattien sa-

rakkeet ja sarake, jossa lukee profiilin nimi, ja sarake, joka sisältää kappaleen GUID-

numeron. Kun poikkileikkauksesta halutaan muuttuva, profile-sarakkeeseen on kirjatta-

va jokaiselle muuttuvan poikkileikkauksen osalle oma mittansa.

Profiilin nimi sekä x-, y- ja z-koordinaatit käyttäjä syöttää itse ja GUID-numero päivittyy

automaattisesti Excel-tiedostoon sen jälkeen, kun Beam Extruder on luonut objekteja.
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GUID-numerolla Tekla pystyy tunnistamaan luodut kappaleet ja ne voidaan muokata

sen sijaan, että luodaan uusia.

Taulukko 3. Excel-taulukko, jota Beam Extruder käyttää palkin luontiin.

Objektit mallinnetaan painamalla Extrude beams -painiketta. GUID-numerot eivät päivi-

ty, jos objektin luonti on epäonnistunut. Jo luodut kappaleet päivitetään klikkaamalla

Update beams. Jos peräkkäisten objektien sijaan halutaan luoda yhtenäistä objektia,

ruksataan Use polybeam -valintaruutu.

5.3.2 Poikkileikkausprofiilit

Poikkileikkausprofiilina käytetään joko jo olemassa olevaa profiilia TS:n profiililuettelos-

ta tai luodaan uusi profiili.

Kiinteät poikkileikkausprofiilit määritetään:

Piirtämällä poikkileikkauksen muoto TS:n mallissa (Modeling > Profiles > Defining a

cross section using polygon).

Käyttämällä Contour plate -levyä (Modeling > Profiles > Defining a cross section

using a plate).

Käyttämällä ulkoista dwg-tiedostoa, jossa on poikkileikkauksen muoto (Modeling >

Profiles > Defining a cross section using a dwg file).
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Muuttuvat poikkileikkausprofiilit luodaan käyttämällä Sketch Editor -työkalua (Modeling

> Profiles > Define Cross Section in Sketch Editor).

Profiilit, joissa on vaihtelevat alku- ja loppupoikkileikkaukset, luodaan Define Profile

With Variable Cross Section -työkalulla (Modeling > Profiles > Define Cross Section in

Sketch Editor). Ensin Define Profile With Variable Cross Section -valintaikkunassa vali-

taan Sketch Editorilla määritetty poikkileikkaus ja sen jälkeen Profile Editor -

valintaikkunassa määritetään, miten profiilin alku- ja loppupoikkileikkaukset vaihtelevat.

5.3.3 Soveltuvuus ja rajoitukset

Beam Extruder on melkein korvaamaton työkalu siltamallinnuksessa, varsinkin isoissa

geometrisesti haastavissa kohteissa. Se osoittautui todella toimivaksi välineeksi pursot-

taa vaikeita ja monimutkaisia objekteja. Vaihtelevien poikkileikkausprofiilien ansiosta

Kruunuvuorensillan kannen, palkkien ja päällysteiden pursotus onnistui täysin. Kuvasta

17 nähdään pätkä sillasta, jossa kannen rakenne levenee.

Kuva 17. Pätkä Kruunuvuorensillan vinoköysisillasta, jossa näkyy miten kannen
poikkileikkausprofiili vaihtelee.

Koko malli voidaan pursottaa käyttämällä yhden tai kahden ohjausviivan koordinaatte-

ja. CAD-mallinnukseen verrattuna kappaleiden pursotus TS-ohjelmassa Beam Extrude-

rilla on huomattavasti vakaampi ja tuloksena on heti käyttövalmis tietomalli. Lisäksi

Teklan uusimmassa 21 versiossa Beam Extruderilla luodut kappaleet voidaan jakaa

Split-kommennolla (Edit > Split), jaetut kappaleet yhdistetään Combine-komennolla
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(Edit > Combine). Koska Beam Extruder on niin kätevä työkalu siltarakenteiden purso-

tuksessa, sitä olisi suotavaa käyttää jo esisuunnitteluvaiheessa, kun poikkileikkauksen

kuvio ja sillan mittaviiva on suunnilleen selvä. Kannen mallinnus AutoCADissa on sel-

västi työläämpi, ja mallinnuksen jälkeen kappaleet on konvertoitava tietomalliobjektiksi.

Sen jälkeen kun kannen rakenteet on pursotettu Teklassa, malli eksportoidaan IFC-

muotoon, jonka jälkeen se voidaan viedä eteenpäin muihin ohjelmiin tai sitä voidaan

käyttää referenssinä yhdistelmämalleissa.

5.4 Tuodun objektin integrointi tietomallimuotoon

Tämän tutkimustyön alkaessa Kruunuvuorensillan projekti oli yleissuunnitteluvaihees-

sa, jolloin kaikki objektit olivat geometriamalleja eikä objekteille oltu asetettu tietomalli-

vaatimuksia. Yleissuunnitteluvaiheen jälkeen seuraa siltasuunnitteluvaihe. Tässä lu-

vussa käsitellään, mitä objekteja ja objektien parametreja on esitettävä siltasuunnittelu-

vaiheessa ja miten TS-ohjelmaan tuoduille objekteille lisätään tarvittavaa tietoa. Taulu-

kossa 4 on esitetty tiedot, jotka on oltava siltasuunnitteluvaiheen tietomallissa.

Taulukko 4. Rakenneosat ja niiden tarkkuus (3, s. 22).

Materiaalitieto Mallin rakenneosien tulee sisältää tiedot sillan raken-
neosien materiaaleista (betoni, teräs, puu).

Raudoitus Raudoitus annetaan määrätietona rakennusosille
(raudoitus-kg/ betoni-m3).

Jänteet Jänneteräksen määrä annetaan määrätietona raken-
nusosille (raudoitus-kg/ betoni-m3).

Köydet Mallinnetaan niin, että köysien lukumäärä ja sijainti
näkyvät mallissa.

Kiinnitysosat Ei mallinneta.

Eristykset ja pintara-
kenteet

Pintarakenteiden ylin pinta mallinnetaan.

Maalaukset ja suojaus Ei mallinneta.

Varusteet ja laitteet Merkittävimmät varusteet mallinnetaan (kaiteet ja

laakerit).

Geotekniset rakenteet Merkittävimmät rakenteet mallinnetaan (massanvaih-

to ja antureiden alusteiden alustäytöt).
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Mallinnettavan tai mallinnetun kappaleen materiaalia vaihdetaan objektin properties-

valintaikkunassa, jossa Material-dialogille syötetään materiaalin nimi tai klikkaamalla

Select-painiketta haetaan materiaali TS:n materiaaliluettelosta. Raudoituksen ja jänne-

teräksen määrä syötetään Finish-dialogille objektin properties-valintaikkunassa. Köydet

ja geotekniset rakenteet tuodaan IFC-referenssinä CAD-mallista ja sen jälkeen ne mal-

linnetaan oikeanlaisina objekteina TS:ssa. Kaiteet tuodaan CAD-mallista Shape Cata-

log -työkalulla. Tuoduista kappaleista selviää kaiteen muoto ja sijainti. Laakereita ei

mallinnettu yleissuunnitteluvaiheessa, joten ne mallinnetaan Teklassa.

6 Tulokset

Tässä työssä tutustuttiin sillan suunnitteluvaiheisiin. Aluksi kartoitettiin, mitä vaatimuk-

sia on asetettu tietomallille eri suunnitteluvaiheissa ja mitä tietoa näissä vaiheissa esi-

tetään. Lisäksi käytiin läpi, mitä työkaluja on käytettävä CAD-mallin tuottamisessa, jotta

jälkeenpäin nämä objektit saadaan vietyä eteenpäin Teklaan. Sen jälkeen tutkittiin,

millä tavalla CAD-objekteja saa tuotua Teklaan ja miten ne konvertoidaan TS-

natiiviobjekteiksi. Lisäksi käytiin läpi, miten rakenteet pursotetaan Teklan Beam Extru-

der -lisätyökalulla. Lopuksi tutkittiin, mitä tietoa ja millä tavalla sitä lisätään Tekla-

ohjelmaan tuoduille objekteille.

Jotta AutoCAD-ohjelmassa mallinnettuja objekteja saisi vietyä Teklaan, ne on mallin-

nettava tilavuusobjekteina eli solid-kappaleina. CAD-kappaleet voidaan tuoda Tekla-

ohjelmaan IFC-referenssinä, jonka jälkeen objektit konvertoidaan natiiveiksi TS-

objekteiksi Convert IFC objects -työkalulla. Koska AutoCAD Civil 3D -ohjelmassa eks-

portointi IFC-tiedostoformaattiin ei onnistu, mallin viennit suoritettiin AutoCAD Architec-

ture - ja Revit Structure -ohjelmissa. AutoCAD Architecturella tehdystä IFC-tiedostosta

saatiin konvertoitua vain AutoCAD Architecturen työkalulla mallinnettuja seinä-, pilari-,

palkki- ja laattaobjekteja. AutoCAD Architecturen sisällä solid-kappaleiden konvertointi

seinä- tai laattaobjektiksi ei vaikuttanut mitenkään Teklassa tehtyyn konvertointiin. Re-

vit Structures -ohjelmassa tehdystä IFC-tiedostosta saa konvertoitua seinä-, pilari-,

palkki-, laatta-, porras- ja vesikatto-objektien lisäksi RS-ohjelmassa tehtyjä vapaamuoto

-objekteja. Jos kappaleella on vähänkään monimutkaisempi muoto, niin sitä ei saada

konvertoitua Tekla-objektiksi. Vaikka tällä menetelmällä yleensä saadaan IFC-

tiedostossa tuodut kappaleet konvertoitua Tekla-natiiviobjekteiksi, ei mitään Kruunu-
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vuorensiltamallin objekteja saatu onnistuneesti konvertoitua, koska ne olivat mallinnettu

vapaamuoto-objekteina.

Toinen tapa, jolla CAD-objektit saadaan TS-malliin tuotua, on TS:n Shape Catalog -

työkalu, jolla yksittäiset objektit importoidaan Shape Catalog -luetteloon, jonka jälkeen

kappaleet sijoitetaan TS-malliin. Tässä työssä Shape Catalog -luetteloon importoitiin

dwg-muotoon tallennetut objektit sekä samat dwg-muodosta IFC-muotoon viedyt objek-

tit. Kaikki Kruunuvuorensilta-mallin CAD-objektit saatiin onnistuneesti importoitua Sha-

pe Catalog -luetteloon ja sijoitettua oikeisiin paikkoihin Tekla-malliin. Kuitenkin dwg-

muodossa tuoduista objekteista vain osa importoitui Shape Catalog -luetteloon vesitii-

viinä solid-objekteina. Geometrisesti vaikeiden objektien importoinnissa tapahtui useita

virheitä. Kannen osista yhtään kappaletta ei saatu tuotua solid-objektina. Suurin osa

sillan tukirakenteista on importoinut solid-kappaleina. Toisaalta kaikki IFC-mudossa

importoidut kappaleet tuotiin onnistuneesti solid-objekteina. Vaikka tämä tapa on työläs

ja kaikki objektit joudutaan tallentamaan yskitellen, jonka jälkeen ne viedään IFC-

muotoon, sen avulla kaikki mallin kappaleet on saatu tuotua Tekla-ohjelmaan natiiviob-

jekteina. Objektit ovat muokattavissa ja niillä on tilavuustietoa.

Sen jälkeen kun kaikki dwg-mallista tuodut objektit saatiin konvertoitua Teklaan Shape

Catalog -työkalulla, kannen rakenteet luotiin TS:n Beam Extruder -lisätyökalulla, joka

pursottaa peräkkäiset palkit millä tahansa poikkileikkausprofiililla. Beam Extruder käyt-

tää mallinnuksessa Excel-tiedostoa, josta luetaan profiilin tietoa ja sijaintia. Pursotuk-

sessa voi käyttää vaihtelevia poikkileikkausprofiileja, jonka ansiosta kaikki Kruunuvuo-

rensillan kannen objektit on saatu pursotettua melko pienellä vaivalla.

7 Johtopäätökset

Opinnäytetyön tehtävät on suoritettu onnistuneesti ja kaikki CAD-mallin objektit on saa-

tu integroitua TS-natiiviobjekteiksi. Kuitenkaan kaikki tutkitut menetelmät eivät sopineet

Kruunuvuorensillan objektien konvertoimiseksi. Työn aikana Tekla Structures ja sen

ominaisuudet ovat tulleet hyvin tutuksi ja on opittu, kuinka korvaamaton IFC-

tiedostomuoto on tietojen siirrossa tietokonejärjestelmästä toiseen. Jotta AutoCAD-

ohjelmassa mallinnettujen objektien muoto ei vääristy IFC-exporttia tehdessä, CAD-

mallinnuksessa on käytettävä yksikkönä millimetrejä metrien sijaan. Beam Extruder -

työkalu osoittautui todella käteväksi tavaksi kannen mallintamisessa. Tässä vaiheessa
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voidaan todeta, että vaikka alussa kansirakenteiden pursotusta Tekla-ohjelmassa jo

yleissuunnitteluvaiheessa pidettiin tarpeettomana ja monimutkaisena, kävi ilmi, että

Beam Extruder -työkalulla kannen pursotus tapahtuu kätevämmin kuin AutoCAD-

ohjelmassa. Ja jos suunnitelmiin on tullut muutoksia, Beam Extruderilla mallinnettuja

objekteja on melko helppo muokata vaihtamalla pursotettujen objektien parametreja

Excel-taulukossa. Mallinnetut kappaleet voidaan tallentaa IFC-muotoon ja ne ovat avat-

tavissa muissa tietokonejärjestelmissä.
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